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PROGRAM OVERVIEW
Pop Culture Day Book is a powerful integrated information management application 
designed specifically for broadcasters and media professionals.    It features sophisticated 
database and reporting capabilities, yet is extremely easy to use.

A wealth of information on people and events is provided in separate database files for each 
month.    Records can be easily added or edited and information can quickly be retrieved by 
searching for any name or group of words.

A report for any day can quickly be created for viewing on-screen or printing out with just a 
couple of clicks.    The report items are automatically sorted chronologically and by category. 
Ages of people with birthdays are automatically calculated based on the current year as 
determined by your computer's clock(a report created in December for a day in January will 
have ages calculated for the following year).

The Memo Pad database file is useful for storing random notes and other bits of information.

The Word Processor can be used to print out any group of selected records from a database 
and to import of data from other applications along with performing the usual word 
processing tasks.

Context sensitive on-line help is provided.    Just press the F1 key to view information about 
the window, menu item, or button which currently has the focus.



KEYBOARD TIPS

Short-cuts using the keyboard
To switch to a different window in the program:

Press CTRL+TAB or CTRL+F6 to switch to the next window.

Press CTRL+SHIFT+TAB or CTRL+SHIFT+F6 to switch to the previous window.

To move the focus to a menu, button, text box, or field:

Hold down the ALT key while also pressing the letter underlined in the name of the control.
For example, to select the command Next press ALT+T.    Many commands also have 
function keys or CTRL plus letter shortcut keys.    Most of these key combinations are 
indicated on the menus.    

To display the items in drop-down list box, press ALT+DOWN while the list box has the 
focus.

To move the cursor position within a body of text:

LEFT ARROW Moves one character to the left.

RIGHT ARROW Moves one character to the right.

UP ARROW Moves one line up.

DOWN ARROW Moves one line down.

HOME Moves to the beginning of a line.

END Moves to the end of a line.

PAGE UP Moves up one window height up.

PAGE DOWN Moves one window height down.

CTRL+LEFT Moves one word to the left.

CTRL+RIGHT Moves one word to the right.

CTRL+END Moves to the end of the text.

CTRL+HOME Moves to the beginning of the text.

CTRL+PAGE DOWN Moves to the bottom of the window.

CTRL+PAGE UP Moves to the top of the window.

To highlight text for copying or deleting:
Hold down the SHIFT key while also pressing the appropriate key combination above.

To toggle insert/overtype mode on or off:
Press INSERT.



See also: Text Overview



WINDOWS CLIPBOARD
The Windows clipboard is a temporary storage area for the transfer of data between text 
areas in this or other applications. The Cut, Copy, and Paste commands transfer data to 
and from the clipboard. 

To Cut or Copy text:

Position the mouse pointer at the start or end of the text you wish to highlight, then:

Hold down the left mouse button, drag the mouse to highlight the text, then release the 
button.
Or...    Hold down the SHIFT key, position the mouse pointer at the opposite end of the text 
you wish to highlight and click with the left button.
Or...    To highlight just a single word double click on it.

Hold down the SHIFT key while also using the appropriate keyboard navigation key to 
position the opposite end of the highlighted text.

See Keyboard Tips

To remove the text and insert it in the clipboard:

From the Edit menu select Cut, or on the toolbar select the Cut button, or press CTRL+X.

To copy the text to the clipboard:

From the Edit menu select Copy, or on the toolbar select the Copy button, or press 
CTRL+C.

To paste text from the clipboard:

Position the cursor at the point at which you wish to insert the text, then from the Edit 
menu select Paste, or on the toolbar select the Paste button, or press CTRL+V.



FILE DIALOGS
File dialog boxes are utilized in various capacities in the program to provide easy selection of
or typing in of the name of a file to be opened, copied, or saved.

File Name

Selects the name of a file to open, save or copy.    The list displays names of files with the file
name extension selected in the List Files Of Type box.    You can also type in the name of a 
file.    To see a list of files with a an extension other than those provided in the List Files Of 
Type box, type an asterisk (*), a period, and the file name extension, and then press ENTER.

List Files Of Type

Selects the type of files to be displayed in the File Name list.    File name extensions listed 
will vary depending on the purpose of the file dialog.

Database (*.agi) Lists database files.

Database (*.dbf) Lists dBASE® compatible files.

Document (*.atx) Lists document files.

Ascii Text (*.txt) Lists Ascii Text files.

Rich Text (*.rtf) Lists Rich Text Format files.

Log file (*.log) Lists communications log files.

Ini file (*.ini) Lists Windows initiation files.

All Files (*.*) Lists all files in the current directory.

Drives

Selects a drive to open a file in, or to save or copy a file to.

Directories

Selects a directory to open a file in, or save or copy a file to.



TECHNICAL SUPPORT
Every effort has been made to make this program easy to use and trouble free.    If you 
suddenly begin to experience problems, check to make sure that you are not running low on 
system resources.    From the Help menu, select About.  If memory is low or User or GDI is 
below 50%, close any program windows or other applications not currently in use.

The confirguration of your computer system or conflicts with other programs can also 
sometimes cause some difficulties.    Check the READ_ME.TXT file for information about any 
known problems.

The information provided in the databases has been thoroughly researched and verified 
against multiple sources, but invariably some errors or changes can occur.    We would be 
interested in learning of any definitive contradicting information you may have.

You will be advised by mail of future updates, so make sure to send us your new address 
when you move.    We would also be interested in hearing of any improvements to the 
program and its documentation that you would like to see in the future.

Phone:

(201) 871-7331    Hours of telephone support may vary depending on other commitments.

Fax:

(201) 871-7305.    Include your fax number.

US Mail:

Echo Airworks
350 Lafayette Street
Cresskill, NJ    07626-1326

Electronic mail:

Airworks@aol.com.    Include your E-mail address.

If you are having what may be a system related problem, it can be helpful to provide 
information about your computer.    To create a print-out of system information which can be 
faxed or mailed, run the Microsoft Diagnostics program (MSD.EXE) which is included with 
Windows.    You can start the program by clicking below.

1. Start MSD.EXE

2. Select the OK button to ignore the suggestion that you run the program from outside 
of Windows,

3. From the File menu select Print Report.

4. Make sure that the Customer Information, System Summary, CONFIG.SYS, and 
AUTOEXEC.BAT items are marked and unmark the rest, then select the OK button.

5. Make sure your printer is on.



6. Fill in the Customer Information, then select the OK button.

Run MSD.EXE



ORDER FORM
Order your copy of Pop Culture Day Book today!

 Over 5000 detailed records

 Complete printed manual

 Special introductory price

Print Order Form

Name ____________________________________________ Phone _________________________

Company ________________________________________ Address given is:    __ work      __ home

Street (not a P.O. box) ______________________________________ Floppy disk size: __ 3½ hd      __ 5¼hd

City ________________________ State ______ Zip ______________

Single user      (introductory price valid through 4/30/95) $125

Five user license pak      (other quantities on request) $395

Sales tax      (New Jersey customers* include 6% sales tax) _____

Shipping      ($6.50 US, $8.50 Canada, $18.00 elsewhere) _____

TOTAL _____

Mail Order To:

Echo Airworks
350 Lafayette Street
Cresskill, NJ    07626-1326
201 871-7331      fax: 871-7305

Credit card orders may be placed through:
Public (software) Library
800 242-4775    Order product #11561
Orders Only!    No information available
Outside US: 713 524-6394      fax: 524-6398
* Texas credit card customers pay 8.25% Texas sales tax.



CHANGING THE MONTH OR YEAR
Calendar files are provided for several years in advance.    If you wish to view a year for 
which no file has been provided, it can automatically be created.    No holidays will be 
marked.

To change the calendar to the previous month:

On the calendar, select the left arrow button, or press F4.

To change the calendar to the next month:

On the calendar, select the right arrow button, or press F5.

To change the calendar to any other month or to reopen the calendar window 
after it has been closed:

From the Calendar menu, select the month you wish view.

To change the calendar to another year:

1. From the Calendar menu select Change Year.    The Change Year dialog box 
appears.

2. Type in the year you wish to switch to.

If a file for the year is not found, you will be asked if you wish to create one.



MARKING DATES AND ADDING MEMOS
To mark a date or add a memo to the currently displayed calendar 
month:

1. Select the day on the calendar which you wish to mark.    If the calendar is set to the 
current month, the current day is the default.

2. On the calendar select the Mark button, or from the Calendar menu select Mark 
Date, or press F9.    The Mark Calendar Date dialog box will appear.

3. Type in a memo to be displayed at the bottom of the calendar on the selected day.    
The maxium text length is 118 characters

4. Select a color with which to mark the date.    Black is the default, purple is for 
holidays, and blue is for special days.

5. Select the OK button.

To erase a previous memo, select the Clear button.    To cancel any change press ESCAPE.

Note:    Calendar memos are totally separate from the Memo Pad database entries and the 
Holiday calendar mark has no relation to Holiday database entries.



VIEWING DAY REPORTS
To create a day report in a window which can also later be printed out:

1. Select the day on the calendar for which you wish to create a report.    If the calendar 
is set to the current month, the current day is the default.

2. On the calendar select the View button, or from the Database menu select View 
Report, or press F7.

A report window, which is created independently from the main application window, will 
appear. The Windows Task Manager will then appear briefly listing the report windows and 
all the programs currently running.    Progress will be indicated at the top of the report 
window as the program sorts through the appropriate database and then displays the 
records for the selected day.

Report window control buttons:

Additional key combinations for report windows:

CTRL+PAGE DOWN Moves to the next page.

CTRL+PAGE UP Moves to the previous page.

HOME Moves to the top of the page.

END Moves to the bottom of the page.

CTRL+HOME Moves to the first page.

CTRL+END Moves to the last page.

Note:    Reports are created using the Arial TrueType font which is provided with Windows.    
If this font is not active on your system, another font will automatically be substituted.      
Appearances may vary.



PRINTING DAY REPORTS
To create a day report which is sent directly to the printer:

1. Select the day on the calendar for which you wish to create a report.    If the calendar 
is set to the current month, the today's date is the default.

2. On the calendar select the Print button, or from the Database menu select Print 
Report, or press F8.

A printing dialog box will appear indicating the progress as the program sorts through the 
appropriate database and then sends the records for the selected day to the printer.

You can also print out a copy of a Day Report from a report window by clicking on the Print 
button.



DATABASE WINDOWS
The database windows provide access to database files for adding or editing individual 
records and for entering information into one or more fields for a search.

To open a database window, from the file menu select the month you wish open.    You can 
also open the database for the current month on the calendar by double clicking on the 
name of the month between the arrow buttons.

In addition to using the TAB key, or pressing ALT plus the underlined character key, or using
the mouse to move around the window, you can also press ENTER to move to the next 
appropriate field.    If the Toggle Active Fields option is checked, database fields are 
automatically enabled or disabled as appropriate for the pre-defined categories.

You can type an entry in the Category and Occupation fields or select from the lists using the
keyboard navigation keys or by clicking with the mouse.    Once the list has the focus, you 
can also select an entry by typing it's first letter.

The Category and Occupation lists can be added to or changed by editing the pcdb.ini file 
using the word processor.    You can also temporarily add the current text of the Category or 
Occupation fields, whichever is active, to the Category or Occupation list by selecting Add 
to List from the Edit menu.

Database window command buttons:

Next Positions the database to the next record.

Previous Positions the database to the previous record.

Clear Clears fields for entry of new data or text for which to search for.

Add Adds a new record containing the currently entered information.

Update Changes an existing record to contain the currently entered information.

Delete Optionally asks for confirmation, then deletes the current record.

Search Searches for a name or group of words entered in the fields.

Find All Restores the full database set for viewing following a search.

Close Closes the database window.

See also: Adding or Editing a Record
Searching For Data



ADDING OR EDITING A RECORD
To add a new record to the database or change an existing one:

1. If you are adding a new record, select the database window Clear button.

2. In the Category field type in or select a category from the list using the keyboard 
navigation keys or by clicking with the mouse.    Maximum text length is 30 
characters.

3. In the Day field, type the day.    Single digit numbers must have a leading zero.

4. In the Text Year field, type the year information which will appear in the report.

5. In the View Year field, if you want a record to appear in a report only during a specific 
year, type the year you want the record to appear.

6. In the Name field, type the name of the person or event.    Maximum text length is 30 
characters.

7. In the Occupation field type in or select an occupation from the list using the 
keyboard navigation keys.    Maximum text length is 44 characters.

8. In the Information field type in any details.    There is no text length limit for 
information.    You can start a new paragraph by pressing CTRL+ENTER or insert a 
tab by pressing CTRL+I.

9. To add a new record select the Add button.    To save changes to an existing record 
select the Update button.



SEARCHING FOR DATA
Pop Culture Day Book allows you to quickly retrieve database records containing any 
name or group of words.    Searches performed are not case-sensitive.    Unless you type in a 
search switch before the text to be searched for, the match must be exact.    This includes 
special characters.    For example, a search for Mel Torme will not find Mel Tormé.

To perform a search:

1. Select the Clear  button from the database window.

2. Position the cursor in the field in which you wish to search.

3. Type the name or group of words you wish to search for, preceded, if necessary, by 
the appropriate search switch.

4. Select the Search button from the database window or press F3.

The message area above the command buttons in the database window will indicate the 
number of records found.

See also:    Auto Searching

Search switches:
\B <text> finds all records which begin with the given text string.    For example, "\b Jo" will 
find names like "Joe", "John", and "Jones".    You can press CTRL + ALT + B to insert "\B " in 
the field which has the focus.

\W <text> finds all records which contain the given text anywhere in the record.    For 
example, "\w to" will find records containing words such as "to".    "stop", and "tomato".    Use
of this operator can be time consuming since it has to search through entire fields of each 
record in the database.    You can press CTRL + ALT + W to insert "\W " in the field which has 
the focus.

\G <text> works like \w but allows the use of periods as wild    card characters. For example, 
"\g O'Bri.n" will find records containing O'Brian and O'Brien.    You can press CTRL + ALT + G 
to insert "\G " in the field which has the focus

> <number> finds records with a value greater than the specified number.

< <number> finds records with a value less than the specified number.
~    <text> finds records not equal to the specified text (may also be used in front of the 
other operators except \b to change the sense of their operation).    For example, "~\w actor"
finds all records that do not have the word actor in the field.



AUTO SEARCHING
To automatically search each month's database for a name or group of words in the Name, 
Occupation or Information fields:

1. From the File menu select Search All, or press F2.    The Search All Months dialog
appears.

2. Enter a name or words to search for, including a search switch if needed.

3. Select the field in which to search.    Name is the default.

4. Select the month in which to start.    January is the default.

5. Select the Search button or press F3.

Each database window will be opened and searched, beginning with the month selected.    
Database files already open will be skipped over.    A status bar will appear at the bottom of 
the main application window indicating the number of matching records found.

To cancel the search press ESCAPE or click on the Cancel button on the status bar.    The 
search will end automatically if an exact match is found in the Name field.

See also:    Searching For Data



GRID VIEW
The grid provides viewing of multiple records at the same time.    You can also update 
information in existing records or copy or delete records using the grid.

Editing Data in the Grid
The current record in the grid is identified by the row with the contrasting color. When 
maneuvering around the grid, the current cell is identified by the cell with the contrasting 
color.    When a cell is opened for editing it will be highlighted and the cursor will appear at 
the beginning of the text.

To make a cell current click on it. To open the current cell for editing click on it, or to open a 
different cell for editing, double click on it.

To make a cell the current cell use the keypad navigation keys or TAB key to move to the 
desired cell.    To open the cell for editing, just begin typing or press BACKSPACE.

If data is changed, records are updated automatically when a cell leaves edit mode. To leave
edit mode, click on another cell or press the UP or DOWN arrow key.

To undo a text change press CTRL+Z or select Undo from the Edit Menu before leaving 
the cell.    To leave a cell without updating the record press ESCAPE.

Note: Information enties longer than 254 characters cannot be edited in the grid.

See also: Keyboard Tips

Grid Configuration
To resize a column, position the mouse over the vertical line at the column's right edge, 
press the left mouse button down and drag the line to the desired location.

To move a column, position the mouse over the column's heading, press the left mouse 
button down and drag the column to the desired location.



MEMO PAD
The Memo Pad is a database file for storing random notes, bits, and other information.    
Each record is stored and sorted based on the date which it was created.    You can quickly 
view a memo for a particular date by clicking that date on the list.    You can edit the date of 
a memo by double-clicking on the date.

There is no text length limit for Memo Pad records.    You can start a new paragraph by 
pressing CTRL+ENTER or insert a tab by pressing CTRL+I.    If you want to start a new 
Memo Pad file just rename or delete the memo.pad file while the Memo Pad window is 
closed.    The next time you add a record a new file will be created.

Memo Pad window command buttons:

Next Positions the database to the next record.

Previous Positions the database to the previous record.

Clear Clears memo field for entry of new data or text for which to search for.

Add Adds a new record containing the currently entered information.

Update Changes an existing record to contain the currently entered information.

Delete Optionally asks for confirmation, then deletes the current record.

Search Searches for a name or group of words entered in the memo field.

Find All Restores the full database set for viewing following a search.

Close Closes the Memo Pad window.



FILE MAINTENANCE
Pop Culture Day Book uses a special database file format to save disk space.    Unlike 
most database file formats, data is saved in variable length fields so that the information 
only takes up as much space as it actually needs.

The database files are installed without indexes.    The first time you open a database 
window an index for the Day field will be created.    Whenever you first conduct a search for 
information in any other particular field, an index for that field will be created.

The database files being rather large, performance of file operations can be hampered if a 
file is not in a contiguous location on your hard disk.    Periodic use of a defragmentation 
utility is recommended to maintain file contiguity.

The AGIFIX.EXE File Repair Utility

If your power goes out or your system crashes while a database is being updated or while 
information is being written, the file will probably not re-open and an error message will be 
displayed.    This does not necessarily mean that there has been any data loss.

To repair the file use the AGIFIX.EXE utility.    It runs under DOS rather than Windows, so you 
will need to run it from a DOS prompt or shell.

Running AGIFIX.EXE:

AGIFIX.EXE requires only a single command line argument, the name of the database file to 
fix.    For example, to repair the file march.agi, you would switch to the Pop Culture Day Book 
directory.    At the DOS prompt ype CD C:\PCDB and press ENTER, then use the command 
agifix march.agi.

The filename must include the .agi extension.    The AGIFIX.EXE program will rename the 
old .agi file as a backup file and will put the data into a newly created .agi file. Up to 100 
backups can be kept (they will be named .bk0, .bk1, .bk2, etc.).    

Under some circumstances a record can be lost if it was being accessed at the time of the 
crash.    The best answer to this is to keep frequent backups of all your data so you can 
retrieve anything which may be lost later.

Running AGIFIX.EXE also has the side-effect of removing all file indexes.    The next time you 
use the file, however, indexes will be recreated.    When AGIFIX.EXE completes its repair of a 
file, it also provides statistics about the database.    This is a sample of the output: 

RECORD INFORMATION

    Number of records: <Total number of records in the file>

    Total bytes of record data: <Total number of bytes used by records>

    Unused record data space: <Number of bytes of empty space> (due to partially filled 
slices)

    Average record size: <Average size of all records>



    Largest record size: <Size of the largest record>

    Smallest record size: <Size of the smallest record>

ATTRIBUTE INFORMATION

    Number of possible attributes: <Total number of fields used in the entire file>

    Average attributes per record: <Average number of fields used in all records in the file>

    Smallest number of attributes: <Fewest number of fields used by a record>

    Largest number of attributes: <Largest number of fields used by a record>

PHYSICAL INFORMATION

    Physical 1024-byte blocks: <Number of blocks used>    (slices reside in blocks)

    Deleted 1024-byte blocks: <Number of blocks deleted>    (will be reused when needed).

    Physical 64-byte blocks: <Number of slices used>    (all records are allocated as slices)

    Deleted 64-byte blocks: <Number of deleted slices>    (will be reused when needed)

    Repaired database: <Name of the repaired database just recreated>

    Backup of original: <Name of the back-up of the original database>



TEXT OVERVIEW
In addition to performing typical word processing tasks, you can also print out any group of 
records from a database by copying the information into a text window.    From the Edit 
menu select Copy to Text to copy the current database record.

You can also import information from any application which allows you to save data in Asciii 
text format.    Use the clipboard to copy information into the appropriate fields in a database 
window.

See Windows Clipboard

Word processor capabilities:

 Left, right, centered, and justified paragraphs.
 Single, one-and-a-half, and double spacing.
 Space before and space after a paragraph.
 Multiple simultaneous font types and sizes.
 Bold, italic, underlined and strike-through text.
 Adjustable preset tabs and manual tabs.
 Reads/writes ATX Document and Ascii Text files.
 Reads/writes Rich Text Format files (limited formatting).
 Text find and text find and replace.

Additional key combinations for document windows:

CTRL+UP Moves one Paragraph up.
CTRL+DOWN Moves one Paragraph down.
CTRL+ENTER Inserts a page break
CTRL+SHIFT+SPACE Inserts a non-breaking space.
ALT+SHIFT+ENTER Inserts a soft line break.
ALT+A Sets focus to the Font Name box.
ALT+Z Sets focus to the Font Size box.



TEXT TOOLBAR

Open button displays the Open Text File dialog box.
Save button saves the active document.    For a new document, displays the Save File As 
dialog box.

See File Dialogs
Print button displays the Print Text File dialog.

See Printing Text Files
Cut button removes the selected text and inserts it in the Windows clipboard.
Copy button copies the selected text to the Windows clipboard.
Paste button copies text the Windows clipboard and inserts it at the cursor position.

See Windows Clipboard
Font Name and Font Size boxes select and display the name and size of the font at the 
cursor position or in the selected text.

See Font Selection
Bold button displays and toggles on or off bold text at the cursor position or in the selected 
text.
Italic button displays and toggles on or off italic text at the cursor position or in the selected
text.
Underline button displays and toggles on or off underlined text at the cursor position or in 
the selected text.
Left, Right, Centered, and Justified buttons display and change the alignment of the 
paragraph at the cursor position or in the selected text.
Single, 1½, and Double buttons display and change the line spacing of the paragraph at 
the cursor position or in the selected text.

See Text Overview

Note:    If the selected text contains multiple fonts or multiple font sizes, the font or size box 
will be blank.    If the selected text contains varied paragraph alignment or spacing, all 
buttons will all be up.



FORMATTING RULER

Formatting paragraphs with the mouse

To change the document text width:

1. Position the mousepointer over the text width indicator.

2. Depress the left mouse button, drag the indicator to the desired new position and 
release the mouse button.

The text width can also be set from the Print dialog box.
See:    Printing Text

To change paragraph indents:

1. Position the cursor in the paragraph you wish to change or highlight multiple 
paragraphs you wish to change.

2. Position the mousepointer over the indicator for the indent you wish to change.

3. Depress the left mouse button, drag the indent marker to the desired new indent 
location and release the mouse button.

To change space before or after a paragraph:

1. Position the cursor in the paragraph you wish to change.

2. Position the mousepointer over the space marker you wish to change.

3. Depress the left mouse button, drag the space marker to the desired new position 
and release the mouse button.

To highlight the entire current paragraph:

Double click between the paragraph space markers.

To insert or remove a manual tab stop:

1. Position the cursor in a single paragraph or highlight multiple paragraphs in which 
you wish to insert a new tab stop.

2. On the ruler, click with the left mouse button where you want to insert the tab stop, 
or with the right mouse button where you want to remove a tab stop.

To clear all manual tab stops click on the end of the ruler above the left margin or from the 
Text menu, select Reset Tabs.

Paragraph settings, along with the measurement units on the ruler and spacing of preset 
tabs, can also be set from the Paragraph dialog box.

See:    Paragraph Dialog





FONT SELECTION
You can change fonts, font sizes, and font styles using the Toolbar or the Font dialog box.    
The Font dialog box also displays a sample of the selected font.    Selecting a font using the 
Font dialog box also sets the default font for new documents.

To change a font type, size, or style:

Position the cursor at the you want to change the font, or to change the font style or size of 
existing text highlight the text, then:

Using the Toolbar:

Click on the down arrow to the right of the Font Name or Font Size box, then click on the 
desired font name or size.    Click on the Bold, Italic, and Underline buttons to toggle 
bold, italic or underlined text on and off.

To set the focus to the Font Name box press ALT+A or to set the focus to the Font Size 
box press ALT+Z.    Optionally, you can display a list by pressing ALT+DOWN.    Select a 
name or size using the UP and DOWN arrow keys or type in the name or size, then press 
ENTER.    To cancel press ESCAPE.    You can toggle bold, italic, underlined or strikethrough 
text on or off from the Text menu.

Using the Font dialog box:

From the Text menu, select Font.    The Font dialog appears.    Select or type in a font 
name, style, and/or size in the Font dialog box. then select the OK button.



PARAGRAPH DIALOG
You can adjust paragraph specifications by typing in a number, pressing the UP or DOWN 
keys, or clicking the mouse on the up or down arrows.    You can also adjust paragraphs using
the toolbar and ruler.

Indents

Sets the indents and preset tabs for paragraph at the cursor position or in the selected text.  
You can create a hanging indent by setting the First Line indent to a negative number 
(number cannot exceed the inverse of the Left Indent number).

Spacing

Before and After sets the space before and after the paragraph at the cursor position or in 
the selected text.    Line sets left, right, centered, or justified alignment of the paragraph at 
the cursor position or in the selected text.    Spacing sets single, 1½, and double line spacing 
of the paragraph at the cursor position or in the selected text.

You can change the unit of measure    by selecting the Inches or Centimeters button.    
Select the Apply button to apply changes to the paragraph formatting.

See also: Text Toolbar
Formatting Ruler



FIND AND REPLACE
To find any name or group of words in a document:

1. From the Text menu, select Find.    The Find Text dialog box appears.

2. Type the words you wish to find (search is not case sensitive).

3. Select the direction for the search (down is the default).

4. Select the Find Next button or press F3.

The program searches for and highlights the next occurrence of specified text in a the active
document.    The search is performed starting at the current cursor position, in the direction 
specified.    You can also press F3 to find the next occurrence even after closing the Find 
Text dialog box.

To find and replace any name or group of words in a document:

1. From the Text menu, select Replace.    The Find & Replace dialog box appears.

2. Type the words you wish to find (search is not case sensitive).

3. Type the words, if any, you wish to replace found text with.

4. Select the direction for the search (down is the default).

5. Select the Replace Next button.

The program searches the active document for the next occurrence of specified text and 
replaces it with the text entered in the replace text box.    Searching and replacing is 
performed starting at the current cursor position, in the direction specified.



PRINTING TEXT
The Print dialog box sets specifications and prints the text file in the active document 
window.

Page Layout

Sets the top, bottom, and left margins, and the text width for the document. You can change 
the unit of measure    by selecting the Inches or Centimeters button.

Print Range

Sets whether all pages or just certain pages or paragraphs are printed.    You can determine 
the number of the paragraph at the cursor position by selecting Location from the Text 
menu.

Setup

Displays the Windows Printer Setup dialog for selecting a printer or printer options.    The 
Options button displays a dialog for controlling printer settings for the selected printer.    To 
get help on the printer, select the Options button, then select the Help button.

Note: The System screen font is used for to display Ascii Text files which retain no character 
formatting.    If you do not change to another font by highlighting the entire document and 
selecting a new font name, the printer will substitute a printer font for you.



FILE MENU
Search All
Displays the Search All Months dialog for entering information for automatically searching 
each month for a word or words in the name, occupation, or information database fields. 

See Auto Searching

January - December
Opens the database file for the selected month.    Menu item is checked when the database 
is currently open.

See Database Windows

Open Other...
Displays the Open Other Database File dialog for selecting a non-month database file to 
open, such as future information updates which will be made available on disk or special 
files you have created. You can also open dBASE® compatible (.dbf) files to copy information
into the month database files.    To do this, the files must be properly configured.

The acceptable field attributes are    CATEGORY (30), DAY(2), YEAR(4), RUNYEAR(4), 
NAME(30), OCCUPATION(44), INFO(Memo).    You do not have to have all these fields in the 
file, however you must not have additonal unsupported fields.    Make sure to back-up your 
original file before reconfiguring it for importing into Pop Culture Day Book.

See File Dialogs

Open Text...
Displays the Open Text File dialog for selecting a document or other text file to open. You 
can also select the Open button on the toolbar.    The System screen font is used for to 
display Ascii Text files which retain no character formatting.

See File Dialogs

New Text
Opens an empty document window for a new file.    The Font dialog box sets the default font
which is used for a new document.

Memo Pad
Opens the Memo Pad window.

See Memo Pad

Back-Up...
Displays the Save Back-Up File dialog for selecting a file to back-up.    After a file is 
selected, the Save Back-Up File As dialog will appear for selecting the name and location 
of the back-up file.    One quick back-up method is to just switch the Drives list from your 
hard disk to your drive containing a floppy disk, saving the file with the same name.

See File Dialogs

Exit



Closes the program.    If any files database files are open or any documents are open with 
changes that have not been saved, you will be asked to confirm closing or saving a file.



EDIT MENU
Toolbar
Displays or hides the text toolbar.

Undo
Undoes the last text edit or deletion.

Cut
Cuts selected text and inserts it in the clipboard. You can also select the Cut button on the 
toolbar

Copy
Copies the selected text to the clipboard. You can also select the Copy button on the toolbar

Paste
Pastes the contents of the clipboard into the active text control at the cursor position. You 
can also select the Paste button on the toolbar

See also:  Windows Clipboard

Select All
Highlights all the text in the active database field or document window.

Overtype
Toggles insert/overtype mode on or off.    Menu item is checked when Overtype mode is on,

Add to List
Temporarily adds the current text of the Category or Occupation fields, whichever has the 
focus, to the Category or Occupation list.    To make a lasting change to the Category or 
Occupation lists, edit the pcdb.ini file using the word processor.

Copy to Text
Copies the current record of the active database window to a document window.    If no 
document window is open, a new window will be created.    If more than one document 
window is open, the record will be copied to the first one opened.

Printer Setup...
Displays the Windows Printer Setup dialog for selecting a printer or printer options.    The 
Options button displays a dialog for controlling printer settings for the selected printer.    To 
get help on the printer, select the Options button, then select the Help button.



DATABASE MENU
View Report
Creates a day report in a window.    The same as pressing the screen button on the Calendar 
window.

See Viewing Day Reports

Print Report
Prints a day report.    The same as pressing the printer button on the Calendar window.

See Printing Day Reports

Next
Positions the database to the next record.

Previous
Positions the database to the previous record.

Search
Searches the active database for a name or words entered in a field in the database window

See Searching For Data

Find All
Restores the full database set for viewing after a search has been performed.

Go to Day
Displays the Go to Day dialog for entering a day to which to reposition the database.    The 
current found set, if their is one, will remain unchanged.

Options...
Menu item is checked when an option is enabled,

Confirm On Delete
Toggles on or off a message asking for confirmation before deleting a database record. 
Delete confirmation is on by default when the program is started.

Toggle Active Fields
Toggles on or off whether database fields are automatically enabled or disabled as 
appropriate for the pre-defined categories.    On by default.

Enable Add Record
Toggles on or off whether the Add button on database windows is disabled until the Clear 
button is pressed.    Switch on if you want to add a copy of record such as an event or 
reminder to an additional day.

Close While Minimized
Toggles on or off whether a database will temporarily close when it's window is minimized.   



Switch on if you are simultaneously working with multiple databases but do not want to risk
leaving them all open a once.

Show Record Number
Toggles on or off whether database record number fields are visible.    Each database record
has a record number which cannot be changed, and deleted numbers are not reused.    The 
higher the number, the more recent the record.

Show Month Number
Toggles on or off whether database month number fields are visible.    Applies only to any 
special non-month database files you have created.



GRID MENU
Maximize/Minimize
Maximizes or minimizes the grid.    You can also click on the grid or a database window with 
the right mouse button to toggle back and forth between a database window and the grid.

Delete Row
Deletes the current record as indicated by the row with the contrasting color.

Delete Set...
Displays a message asking if you wish to delete the current set.    CAUTION: If a find set has 
not been selected, the entire database will be deleted.

Copy Row...
Displays a file dialog for selecting a file to which to copy the current record as indicated by 
the row with the contrasting color.    If the record is from a month file and the file to which 
the records are to be copied is not, you will be asked if you wish to add a month entry to the 
record.

Copy Set...
Displays a file dialog for selecting a file to which to copy the current database set.    If the 
records are from a month file and the file to which the records are to be copied is not, you 
will be asked if you wish to add a month entry to each record.

See File Dialogs

Sleep Set...
Displays a message asking if you wish to remove records in the current database set from 
those that appear in day reports by automatically inserting "0000" in each View Year field.    
CAUTION: Any previous entries in the View Year field will be overwritten.

For example, to keep birthdays of country artists from appearing in day reports:

1. In the database window Occupation field type "\b country".

2. Select the Search button or press F3.

3. Switch to the Grid View window.

4. From the Grid menu, select Sleep Set.

5. Select the OK button when asked for confirmation.

Wake Set...
Displays a message asking if you wish to re-enable records in the current database set to 
appear in day reports by automatically deleting "0000" or any other entry in each View Year 
field.    CAUTION: Any previous entries in the View Year field will be overwritten.





TEXT MENU
Bold
Toggles bold text on or off.    Menu item is checked when Bold text is on.

Italic
Toggles italic text on or off.    Menu item is checked when italic text is on.

Underline
Toggles underlined text on or off.    Menu item is checked when underlined text is on.

Strikethrough
Toggles strikethrough text on or off.    Menu item is checked when strikethrough text is on.

Font...
Displays the Font dialog box for selecting text fonts.

See Font Selection

Paragraph...
Displays the Paragraph dialog box for formatting text paragraphs.

See Paragraph Dialog

Location
Displays a message indicating what paragraph the cursor or the start of selected text is in.    
Useful for determining paragraph numbers when printing specific paragraphs.    In Ascii text 
files, each line counts as a paragraph.

See Printing Text

Reset Tabs
Clears all tabs set manually clicking the mouse on the ruler.

See Formatting Ruler

Find...
Displays the Find Text dialog for locating a word or words in a document.

Replace...
Displays the Find & Replace dialog for locating and replacing a word or words in a 
document.

See Find & Replace

Save
Saves the active document.    For a new document, displays the Save File As dialog box.    
You can also select the Save button on the toolbar.

Save As...



Displays the Save File As dialog box for selecting a file name for a new file or a copy of a 
file under a different name.

See File Dialogs

Print...
Displays the Print Text File dialog box    for printing a document.

See Printing Text



CALENDAR MENU
Mark Date
Displays the Mark Calendar Date dialog for marking a date and entering information to 
add a memo in the current calendar month.

See Marking Dates and Adding Memos

January - December
Changes the calendar to the selected month.    Menu item is checked for the month that is 
currently displayed.

Change Year
Displays the Change Year dialog for entering a year to which to switch the calendar to.    If 
a file for the year entered is not found, you will be asked if you wish to create one.



WINDOW MENU
Switch To...
Displays the Windows Task Manager.

Cascade
Arranges windows in a cascading pattern.

Resize
Resizes the active database window to its default size.    You can also resize the window by 
clicking on the background with the left mouse button.

Color...
Displays the Color dialog box for selecting the background color of the active database 
window or text window.    Useful when editing multiple database files to more clearly indicate
which database window you are currently working in.    To return to the default color press 
Cancel, then select Yes when asked if you wish to return to the default color.

Arrange Icons
Arranges the icons of minimized windows at the bottom of the main application window.

<Window Titles>
Lists the open program windows.    Does not list Report or Help windows.    Select a window 
title to switch to it.



HELP MENU
Current Topic
Opens the help window to a topic which pertains to the active application window.

Contents
Displays the Help Table of Contents.

Search...
Displays the Help Search dialog for locating a Help topic.

Using Help
Displays help on how to use Help.

About...
Displays the About Pop Culture Day Book window containing the program version 
number and other information.    The system resources indicators show the current state of 
your system.    If memory is low or User or GDI is below 50%, you should close any program 
windows or other applications not currently in use.    



A database switch or operator is a special character typed preceeding the text you wish to 
search for which alters the criteria for the search.



A database is a specially formatted file which stores data in a separate unit for each record.
This allows quick retrival of data in response to a query by the user.



A field is a component of a database record displayed as a text box (Name, Day, etc.) in a 
database window.



Justified text evenly lines up along both the left and right edges of a paragraph.



A program operation is case-sensitive if it differentiates between a upper-case and lower-
case letters in a word.




